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HOUDINI FOUNDATIONS 

モデリング、レンダリング、 
アニメーション 
Houdini へようこそ。このレッスンは、サッカーボールのモデリング、レンダリング、アニメーション、シミュレーショ
ンをゼロから行います。スクワッシュ＆ストレッチ（潰しと伸ばし）の理論を使用して昔ながらのバウンシングボール
のアニメーションを作成し、テクスチャとマテリアルを適用し、ライトとカメラを追加します。また、ダイナミクスを
使用してサッカーボールの一群をシミュレートする方法も探ります。 

はじめての Houdini シーンを作成し、Houdini のさまざまな部分を確認し、インターフェースや必須のツールなど
を実際に使っていきます。Scene View でインタラクティブに作業する方法と、ネットワークビューを使用してノー
ドを管理しながら、モデルを整えたり、アニメーションリグを構築する方法を学びます。また、Solaris ステージで
マテリアルとテクスチャをセットアップしてから、Houdini の組み込みのレンダラである Karma を使ってレンダリン
グし、最後にはリジッドボディシミュレーションを作成します。

レッスンの目標
Houdini のプロシージャルなノードベースのワークフローを使用して、サッカーボールのモデリング、 
レンダリング、アニメーション、シミュレーションを行います。

学習内容
	� View ツールを使用する方法
	� シェルフ、Radial メニュー、Tab キーを使用する方法
	� ジオメトリを作成する方法
	� ノードとネットワークを使用する方法
	� カスタムアトリビュートと For-Each ループ をセットアップする方法
	� マテリアルとテクスチャ UV をセットアップする方法
	� ショットのレイアウトを作成し、Karma でレンダリングする方法
	� キーフレームを設定し、Motion FX を追加する方法
	� リジッドボディダイナミクスを使用する方法

使用する機能とソフトウェア
Houdini 19.5+ の機能を前提として、書かれています。

このレッスンの手順は、 
以下のHoudini 製品で実行可能です。

Houdini Core ✔

Houdini FX ✔

Houdini Indie ✔

Houdini Apprentice ✔

Houdini Education ✔

ドキュメントバージョン 4.0 | 2022 年 7 月
© SideFX Software



プロジェクトファイル
SideFX.com の サッカーボールチュートリ
アルのページ（このドキュメントを入手した場
所）から、intro_lesson  ディレクトリをダウ
ンロードします。home または documents 
ディレクトリにある、Houdini Projects ディ
レクトリに配置してください。   

パート 1 

Houdini UI の確認
はじめに、Houdini ワークスペースと、頻繁に使うことになる 3 つのペインを理
解しておきましょう。ビューポートではオブジェクトをインタラクティブに作成でき、
パラメータエディタではノードプロパティを編集でき、ネットワークエディタでは
ノードネットワークを直接操作することができます。   

01 File > Set Project を選択します。ダウンロードした intro_
lesson  ディレクトリを見つけ、Accept を押します。これで、この

ショットに関連するファイルがすべて、先ほどコピーしたプロジェクトディレ
クトリとそのサブフォルダに配置されるようになります。 

File > Save As... を選択すると、新しい intro_lesson  ディレクトリが表示
されます。ファイル名を soccerball_01.hip（または football_01.hip）に
設定し、Accept をクリックして保存します。 

02 ビューポートで、C を押して Radial メニューを表示します。この
メニューから Create > Geometry > Box を選択します。カーソ

ルの位置に、シーン内への配置待ちの状態にあるボックスの輪郭が表示さ
れます。Enter を押して、原点の位置に配置します。

Scene View にボックスが作成され、ネットワークエディタにノードが追加さ
れ、パラメータエディタにはオブジェクトパラメータが表示されます。これ
らの各種インターフェース要素を使用しながら、プロジェクトを進めていき
ます。

03 Houdini の View ツールを見ていきましょう。次のホットキーを
押してください。

	� タンブル	 スペースバーまたは Alt（Opt）+ LMB クリック + ドラッグ
	� パン	 スペースバーまたは Alt（Opt）+ MMB クリック + ドラッグ
	� ドリー	 スペースバーまたは Alt（Opt）+ RMB クリック + ドラッグ

ホームをすることで、ビューをリセットしたい場合もあります。そうし
た場合に便利なホットキーもあります。

	� Home Grid	 スペースバー + H
	� Home All	 スペースバー + A
	� Home Selected	 スペースバー + G

Radial メニュー
Houdini のツールには、X、C、V のホットキーを使ってアクセスできる 
Radial メニューからもアクセスできます。いずれかのホットキーを押すと、
Radial メニューが表示され、各種オプションを選択できます。各メニューの
主な内容は次の通りです。

	� スナップ 	 X
	� メイン（またはカスタム）	 C
	� ビュー	 V

52

HO
UD

IN
I F

OU
ND

AT
IO

NS
 



選択のホットキー
Select、Move、Rotate、Scale、Handles ツールを使用する場合、 
次のホットキーで選択モードと作業するレベルを決定します。

	� オブジェクト 	 オブジェクトレベル	 1
	� ポイント 	 ジオメトリレベル	 2
	� エッジ	 ジオメトリレベル 	 3
	� プリミティブ/ 面 	 ジオメトリレベル	 4
	� 頂点 	 ジオメトリレベル	 5

RMB クリックでメニューにアクセス

07 チェーン内のノードをいくつか選択してみましょう。選択したノー
ドのハンドルが表示されますが、表示は最終的な形状のままで

す。各ノードの Display フラグを設定し、表示ノードを変更してみましょう。
バイパスやテンプレートといったフラグも試してください。polyextrude  
ノードをネットワークから移動して、その後同じ場所に戻します。 

最後に、すべてを元に戻し、subdivide  ノードの Display フラグを設定し
ます。これは非常に重要です。Display フラグによって、オブジェクトレベル
での表示が決まるからです。Display フラグは必ず正しく設定してください!

04 オブジェクトを選択した状態で、I を押し、そのジオメトリレベル
に移動します。Shift キーを使ってハンドルをドラッグし、原点を

中心に Z 軸に沿って長くします。

Houdini でオブジェクトを作成すると、オブジェクトのトランスフォームを管
理するオブジェクトレベルと、形状を定義するジオメトリレベルができます。
I を押すと、このオブジェクトのジオメトリレベルに入ることができます。 
また、ネットワークエディタでオブジェクトノードをダブルクリックしても、 
ジオメトリレベルに入れます。後でオブジェクトレベルに戻るには、U を押
します。

05 S を押して Select ツールに切り替えたら、4 を押してプリミティ
ブの選択にアクセスします。N を押してすべてを選択してから、

C を押して Radial メニューを表示し、Model > Polygons > Poly Extrude 
を選択します。 

Scene View の上部にあるオペレーションコントロールツールバーまたはパ
ラメータエディタで、Divide Into を Individual Elements に設定し、ハン
ドルを使用して Distance を約 0.4 に設定します。これにより、各プリミティ
ブの法線に沿って面が押し出されます。 

ネットワークビューには 2 つのノードが表示されています。Houdini では手
順を進めるたびにノードが作成され、それらのノードでシーンを調整してい
きます。

06 N を押して新しい面をすべて選択したら、Tab を押して sub… 
と入力し、リストから Subdivide を選択します。Houdini のツー

ルにアクセスするには、Tab キーも便利な方法です。ツール名を入力する
と、リストに候補のツールが表示されるので、サブメニューをナビゲートしな
くても必要なツールを簡単に見つけることができます。

パラメータエディタで、Depth を 2 に設定します。ジオメトリが細分化され、
ポリゴンの数が増えます。Houdini には、オブジェクトレベルで細分化を表
示できるオプションもあり、ジオメトリを実際に追加しなくても細分化を確
認できます。しかしここでやりたいことは、ポリゴンの作成です。 
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パート 2

サッカーボールの作成
次は、ボックスをサッカーボールの形をしたプラトン立体に置き換えます。Houdini のプロシージャルなアプローチなら、Box ノードを 
Platonic Solids ノードに置き換えられます。そこから他のノードを調整して、サッカーボールらしい見た目にします。入力ノードの置き換
えができるため、シンプルなジオメトリでネットワークのプロトタイプを作成しておけば、柔軟性が高まります。 

01 ネットワークエディタで、Tab キーを使用して Platonic Solids 
ノードをネットワークに追加します。クリックしてチェーンの最上

部付近に配置します。platonic  ノードを polyextrude  に接続します。パラ
メータエディタで、Solid Type を Soccer Ball に設定します。box  ノードを
選択して削除します。

Houdini はプロシージャルのため、入力ノードを変えても、ネットワーク全
体が適切に機能することは珍しくありません。作業の柔軟性が高まるだけ
でなく、変更後の結果が気に入らなければいつでも、元の形状を接続し直
せばよいわけです。

02 polyextrude  ノードを選択します。Handle ツールがアクティブ
になっていることを確認したら、ビューポートでハンドルを使用

して、Distance の値を下げます。パラメータエディタでパラメータ値を設
定してもかまいません。これでサッカーボールらしい見た目になりました。
subdivide  ノードを表示している場合でも、polyextrude  ノードを選択す
ると、そのハンドルとパラメータにアクセスできることを覚えておきましょう。

このプリミティブタイプで準備がすべて整ったと思うかもしれませんが、実
際には、平らな面で構成された切頂正二十面体にすぎません。丸いサッカー
ボールが必要なので、もう少し手を加える必要があります。 

03 ビューポートで V を押し、Radial メニューで Shading > 
Smooth Shaded を選択します。ビューポートの右上のメニュー

を使用しても、シェーディングを変更できます。

このサッカーボールは、正式な革製のサッカーボールではなく、安いビニー
ルボールのように見えます。これからノードを追加し、分岐させながら見た
目を向上させていきます。

分析を終えたら、シェーディングの設定を Smooth Wire Shaded に戻し
ます。

シェーディングオプション
View Radial メニューまたはビューポートの右上にある Shading  
メニューから、さまざまなシェーディングオプションを使用できます。 
オブジェクトのシェーディングでは、ビューポートの右端にある表示オプ
ションでライティングが決まります。ヘッドライト、通常のライティング、
シャドウ付きの高品質なライティングのいずれかを選択できます。 
シェーディングビューからワイヤーフレームに素早く切り替えるには、 
W キーを押します。

Disable Lighting

Headlight Only

Normal Lighting

High Quality Lighting

High Quality with Shadows
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05 platonic  ノードと polyextrude  ノードの間に、subdivide  ノー
ドをドラッグします。接続されたワイヤー上にドロップすると、 

自動的に挿入されます。挿入されない場合は、接続されるまで少し動かし
てみてください。押し出される前に、球のディテールが増加します。

06 ネットワークエディタで Tab キーを使用して Ray ノードを追加
し、subdivide  の後に接続します。次に、sphere ノードをネッ

トワークに追加して、Radius を 1, 1, 1 に、Primitive Type を Primitive 
に設定します。sphere を ray  ノードの 2 つ目の入力に接続します。これに
より、細分化されたボールが完全な球に投影されます。 

これは、Houdini の非常に強力なノードです。あるジオメトリのポイントを
別のジオメトリに投影します。細分化されたサッカーボールが完全には丸く
ないという、ここでの問題にぴったりの解決策です。

07 polyextrude ノードに Display フラグを再度設定します。
Divide Into を Individual Elements に設定すると、すべての

小さいポゴンが押し出されますが、それは望ましくありません。Connected 
Components に設定して、すべてのポリゴンが押し出されるようにします。

このネットワークでは、ボールが細分化された後で、サッカーボールの元の
パッチを押し出す方法が必要です。これを行うには、元のジオメトリのプリ
ミティブ番号を使用します。

04 ネットワークビューで Y を押し、subdivide  ノードと 
polyextrude  ノードをつなぐワイヤーを横切るようにドラッグ

して、接続を解除します。より丸みのあるサッカーボールになるように、
subdivide を残り 2 つのノードの間に移動します。 

Ray ノード
Ray ノードは、ポイントを別のジオメトリに投影するツールです。おもちゃのピンアートに似ていま
す（子供の頃に遊んだことはありませんか）。実際、これは Houdini でピンアートのボードをセッ
トアップするために使用するノードです。
ヘルプの確認 | 各ノードについて詳しく知りたい場合は、パラメータエディタの右上にある  ヘ
ルプボタンをクリックすると、そのノードのオンラインドキュメントが表示されます。シェルフのツー
ル上にカーソルを置いて、F1 を押してもヘルプを確認できます。Houdini で開けるサンプルファ
イルが用意され、そのノードの機能を学べるようになっているヘルプもたくさんあります。
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アトリビュートの使用
アトリビュートは、ポイント、プリミティブ、頂点に割り当てることができ
ます。一般的なアトリビュートには、カラー（Cd）や UV などがあります。
ノードにカーソルを置いて Radial メニューから i を選択すると、チェー
ン内の任意の場所でアトリビュートを確認できます。また、Geometry 
Spreadsheet パネルでもアトリビュート値を確認することができます。
このレッスンでは、patches  というカスタムアトリビュートを作成し、
For-Each ループで活躍してもらいます。

01 AttributeCreate ノードを platonic  ノードの後に追加しま
す。Name を patches  に、Class を Primitive に設定します。

Value フィールドの最初の値を @primnum に設定します。 

このエクスプレッションは、プリミティブ番号アトリビュートを取得し、それを 
patches  という新しいアトリビュートに変換します。 

02 attributecreate  ノードを選択した状態で、メインのビューポー
トの横にある Geometry Spreadsheet タブをクリックします。

Primitive ボタンをクリックすると、左側にプリミティブ番号が表示され、
パッチの色を示す 3 つのカラーアトリビュートと、プリミティブ番号と一致す
る patches  アトリビュートも表示されます。 

ray  ノードをクリックします。このアトリビュートは、形状が細分化されると
きに繰り越されます。もっと多くのプリミティブがあることが分かりますが、
patches  アトリビュートは 31 までで、その後は 0 に戻ります。

03 Scene View タブに戻り、Display Options バーの  
  Visualization ボタンを RMB クリックし、Scene の横にあ

る +（プラス）記号をクリックして、Marker を選択します。Edit Visualizer 
パネルで、Name と Label を Patch_Numbers  に、Type を Marker に、
Class を Primitive に、そして Attribute を patches  に設定します。 

パート 3

For Each ノード
ここで魔法が働きます。最後に作成したアトリビュートを For-Each ループに送り、それぞれの元のパッチに多数のポリゴンが含まれてい
ても、それらのパッチが押し出されるようにします。ポリゴンを押し出した後、もう一度細分化すると、サッカーボールが革製らしく見える
ようになります。 

patches = 0
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05 ネットワークエディタで Tab を押し、For-each Named 
Primitive と入力して、2 つのノードにアクセスしてシーンに

配置します。ray  ノードと polyextrude  ノードの間に foreach_begin  
を接続し、polyextrude  ノードの後に foreach_end  を接続します。
foreach_end  ノードを選択し、パラメータエディタで Piece Elements は 
Primitives に設定したままにし、Piece Attribute を patches  に設定しま
す。foreach_end  ノードに Display フラグを設定します。

patches  アトリビュートに基づいて、元のパッチが一斉に押し出されている
のを確認できるはずです。押し出されていない場合は、polyextrude  ノー
ドで Divide to が Connected Components に設定されていることを確
認してください。

06 Single Pass の横にあるチェックボックスをクリックし、どうな
るかを確認します。スライダをドラッグして、それぞれのパッチが

個別に押し出される様子を確認してください。10 よりも大きい値に設定す
ると、さらに多くのパッチを確認できます。

Single Pass をオフにして、完全な形状を表示します。for-each  ノードがす
べてのパッチを作成し、最終的なジオメトリを返します。For-Each ループは、
Houdini で頻繁に使用する強力なノードセットです。

07 foreach_end  ノードの後に Fuse ノードを追加し、その 
Display フラグを設定します。これは、ピースをつなげて単一の

トポロジにするノードです。for-each  ノードでは、バラバラのパッチに分割
しましたが、それらを再結合することはしませんでした。

Fuse の後に Subdivide ノードを追加します。depth を 2 に設定します。
ビューポートでディテールが加わり、これを使用してモデルを評価できるよ
うになります。ポリゴンの数は増えますが、まだ真の細分化サーフェスとし
てレンダリングされるわけではありません。Houdini では、ジオメトリを追
加することなく、ビューポートで細分化表示を設定することも可能ですが、
この Subdivide ノードはレッスンの後半で必要となります。

08 サッカーボールが革製に見えるように、polyextrude  の値を変
えて試しましょう。ここでは Distance を 0.1、Inset を -0.02 に

設定してください。パッチが丸みを帯びて、ルックが向上します。 

オブジェクトレベルに移動し、パラメータエディタでオブジェクトの名前を 
soccerball_geo  に変更します。ノードを選択するか、F2 を押すか、名前
をダブルクリックします。Render タブをクリックし、Render Polygons as 
Subdivisions (Mantra) をオンにして、レンダリング時の真の細分化をセッ
トアップします。  Render Region ツールを選択したら、ビューポートで
サッカーボールの周りにボックスを描き、プレビューレンダリングを作成しま
す。キャンセルするには、その領域の右上にある X ボタンをクリックします。

04  Visualization ボタンがオンになっていることを確認します。
ビューポートのサッカーボール上にパッチの値が表示されていま

す。元のプラトン立体からのプリミティブ番号が、細分化された面に転送さ
れています。Display フラグを別のノードに設定して、関係を確認してみま
しょう。この情報は、For-Each ループを使用して適切にパッチを押し出すた
めに使用されます。

Visualization ボタンをオフにして、作業内容を保存します。ここまでの手順
について、やや抽象的で専門的すぎると感じているかもしれませんが、大丈
夫です。努力はもうすぐ実を結びます。

attributecreate  ノード ray  ノード
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パート 4

UV のセットアップ
マテリアルやテクスチャをセットアップするには、オブジェクトに適切な UV がセットアップされていることが大切です。 
Houdini のジオメトリには UV が付属していないため、自分で作成しなければなりません。つまり、ネットワークにノードを追加する 
必要があり、ここでは UV Quickshade と UV Flatten ノードを追加します。

01 soccerball_geo  オブジェクトの中に入ります。ネットワーク
ビューで、Tab > UV Quickshade を押し、foreach_end  ノード

のすぐ後に新しいノードを追加します。Display フラグ を設定します。

Texture Map の横にあるファイル選択ボタンをクリックします。/tex フォ
ルダに移動し、soccerball_color.rat  を選択します。このテクスチャマップ
がジオメトリに表示されますが、投影方法を使用して UV を作成したため、
全体が引き伸ばされたように見えます。

注 : 既存のテクスチャに合わせて UV をセットアップするのは、通常の作業
順ではありません。逆の順番をあえて使っているのは、自分でテクスチャを
ペイントする必要がないからです。 

02 Scene View で、N を押してすべてを選択してから、Tab > UV 
Flatten を選択します。Group フィールドで、@patches>19 と

いうエクスプレッションを入力します。これにより、パッチ境界を使用してサッ
カーボールジオメトリの暗いパッチが平坦化され、UV がレイアウトされま
す。   

このツールを使用すると、UV ビューが表示されます。右上の UV (vertex) 
メニューをクリックして、Background > soccerball_color.rat  を選択しま
す。すると UV パネルの背景にこのテクスチャが表示されます。このテクチャ
には、画像の中央にチームのロゴが、上部には暗いパッチのための暗い領
域が含まれています。   

03 Handle ツール を RMB クリックし、Min:  ハンドルをオンにしま
す。下部にある矢印ハンドルを、すべてのパッチがテクスチャマッ

プ上部の暗い領域内に入るまで引き上げます。

このノードを fuse  または subdivide  の後に配置していたら、使用する境界
はなかったでしょう。Houdini では既存のネットワークの途中で UV をセット
アップでき、作業に柔軟性を持たせられます。

04 uvflatten  ノードの後、Fuse ノードの前に、もう 1 つ UV Flatten 
ノードを追加します。Group フィールドで、@patches<20 とい

うエクスプレッションを入力します。これにより、明るいパッチが平坦化され
ます。 

Handle ツール を RMB クリックし、Min:  ハンドルをオンにします。上部に
ある矢印ハンドルを、すべてのパッチがテクスチャマップ下部の明るい領域
内に入るまで引き下げます。

完了したら、Handle ツール を RMB クリックし、Min:  ハンドルをオフにし
ます。

Scene View で RMB クリックし、メニューで Texture Visualization > Off 
を選択します。これでグリッドが非表示になります。

上にドラッグ

下にドラッグ
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06 UV ビューに移動し、ピンとパッチをロゴの中央になるように移
動します。Y を押して回転ハンドルに切り替え、パッチを回転して

ロゴの位置を調整します。   

UV ビューでパッチの頂点をピン留めすると、位置を固定できます。最初は
隣接するパッチとのオーバーラップがいくらかありますが、再パックによって
簡単に修正できます。

05 uvflatten  ノードを選択し、Handle ツールをクリックします。ジ
オメトリ上にカーソルを置くと、パッチがハイライトされるのが分

かります。ビューポート上部にあるオペレーションコントロールツールバー
の Pin Vertices ボタンをクリックします。 

この画像に表示されたパッチにカーソルを置き、3D ビューで、目的のパッチ
の中央の頂点を Shift クリックして選択します。UV ビューに、ピンと操作用
のハンドルが追加されます。

07 オペレーションコントロールツールバーの Repack ボタンをク
リックして、新しいパッチを中心に残りのパッチを再編成します。

引き続きピンを使用してパッチを動かせますが、UV のオーバーラップを回避
するには、もう一度再パックが必要です。   

08 quickshade  ノードをバイパスに設定し、テクスチャマップの割
り当てを非表示にします。このノードが必要なのは、UV をセット

アップするときのみです。サッカーボールに UV グリッドが表示されます。 

パースビューで UV を非表示にするため、Display Options バーで Show 
UV Texture when UV’s Present ボタンをオフにします。

Null ノードをチェーンの終端に追加して、名前を GEOMETRY_OUT  に変
更します。ネットワークチェーンの終端の定義には、この種のノードを使うこ
とをお勧めします。作業内容を保存します。

UV FLATTEN
UV Flatten ノードの動作は、2 つの工程で構成されています。シーム（継ぎ目）によって定義された、
個々のテクスチャのピースを受け取り、それらを 2D テクスチャ空間へと平坦化して、ポリゴンサイズ
の均等化を試みます。 
このノードで、平坦化アルゴリズム用の拘束を追加することができます。この拘束により、レイアウトア
ルゴリズムが強制的に特定の条件を満たすようにすることで、最終的な UV レイアウトをさらに制御で
きるようになります。このノードの状態で、ツールを使って拘束を指定すれば、ノードをインタラクティ
ブに使用できます。または、Enable Manual Layout をオフにすると、このノードをプロシージャルに
使用できるようになります。

Shift クリック

UV テクスチャの表示
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パート 5

レイアウト : カメラとライト
レンダリング用のシーンを作成するには、ジオメトリを Houdini の Solaris または LOP コンテキストに取り込むことになります。 
これは、ルックデブ、レイアウト、ライティングに特化した環境で、USD (Universal Scene Description) を基盤に構築されています。 
これを使用すると、Solaris ワークフローの一部として、Scene View で適切に動作する Karma レンダラでレンダリングすることができ
ます。

01 ネットワークビューで、Tab > Match Size を押し、subdivide  
と GEOMETRY_OUT null  の間にこのノードを追加します。

GEOMETRY_OUT  ノードに Display フラグを設定します。 

matchsize  ノードを選択し、Justify Y を Min に設定して、地上に乗るよう
にボールを引き上げます。これで、正しい位置でレンダリングできます。

02 デスクトップを Solaris に変更します。パスバーに stage と表示
されていることを確認してください。 

ネットワークビューで Tab > Scene Import を選択し、クリックしてノードを
配置します。Force Objects フィールドの横にあるノードセレクタボタンを
クリックし、ポップアップウィンドウで soccerball_geo  オブジェクトを選択
してから Accept Pattern をクリックします。 

Scene View で、スペースバー + H など、ビューのリセット用ツールを使用
して、サッカーボールがよく見えるようにします。

注 : Objects フィールドではなく Force Objects を使用します。Force 
Objects は、オブジェクトの Display フラグがオフになっていても、LOP 
にオブジェクトを取り込むからです。

03 ネットワークビューで、Tab を押して Grid と入力します。ク
リックしてノードを配置し、名前を backdrop  に変更します。

backdrop  ノードをダブルクリックして、ジオメトリレベルに入ります。 

grid  ノードを選択し、Size を 80, 80、Center を 0, 0, -20 に設定します。 
grid  ノードの出力を RMB クリックして、Bend と入力します。クリックして
ノードを配置したら、Display フラグを設定します。Bend を 75、Capture 
セクションで Capture Origin を 0, 0, -30、Capture Direction を 
0, 0, -1、Capture Length を 5 に設定します。 

grid  ノードの出力を RMB クリックして、Subdivide と入力します。
Display フラグを設定し、Depth を 2 に設定します。

04 ステージレベルに戻ります。backdrop  ノードを sceneimport  
に接続します。sceneimport の出力を RMB クリックし、

Camera と入力します。Enter を押してノードを配置したら、その Display 
フラグを設定します。   

Scene View で、原点にカメラハンドルが表示されます。ズームアウトして
シーンを見下ろすようにしたら、カメラが左側からサッカーボールを見るよ
うにハンドルを調整します。地面に沿ってハンドルを動かしたい場合には、
コンストラクション平面をアクティブにすると操作がしやすくなります。 
また、軸ハンドルで方向を制御したり、カメラを地面から持ち上げることも
可能です。
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09 ネットワークビューで、lights  ノードの出力を RMB クリックし、
Light Mixer と入力してから Enter を押してノードを配置し、 

その Display フラグを設定します。パラメータエディタに特殊なパネルが 
作成され、左側にライトがリストされます。 

3 つのライトをリストから右側の領域にドラッグします。星アイコンをクリッ
クして各ライトをソロにして寄与度を定めたら、Exposure でライティング
を微調整します。intensities がとても高いので、強度バーの上のアイコン
をクリックし、ポップアップメニューでショットに適した Max Value を設定し
ます。完了したら、Solo ボタンをオフにしてすべてのライトを表示します。

06 LOP Lights and Camera シェルフで Environment Light 
ツールをクリックし、Enter を押してそれを原点に配置します。

Intensity を 0.5 に設定し、少し和らげます。

カメラメニューの左にあるメニューをクリックし、Karma に設定します。 
これで、ビューポートで Karma レンダラが使用されるようになります。

Nvidia グラフィックカードがあり、最新のドライバをインストールしてい
る場合は、Optix Denoiser をオンにすると、画像をより素早く処理できま
す。Display Options バーでそれをオンにするか、D を押して Render 
Display Options の Enable Denoising を設定します。

05 Scene View の右上の No cam  メニューをクリックし、
camera1  を選択します。これでカメラ越しに見えるようになり、

見え方を調整できます。 

求めているのはこのビューではないでしょう。いくらか変更します。Scene 
View の右側にある  Lock camera to view ボタンをクリックします。 
表示ツール（スペースバー + LMB/MMB/RMB）を使用してカメラの位置を
調整します。 

重要 : 完了したら、Lock Camera ボタンをオフにします。

07 LOP Lights and Camera シェルフで Point Light ツールをク
リックし、Enter を押してそれを原点に配置します。ライト越し

に見えるようになります。カメラを再度 camera1  に設定します。

ノードをアクティブにした状態で、Shift + F を押して Shadow モードをオ
ンにします。オペレーションコントロールツールバーでクリックしても同じ
です。サッカーボールの上部をクリックしてピボットポイントを設定したら、
Shift クリックして地面にターゲットを配置します。Ctrl ドラッグ でライトの
距離を設定します。

Ctrl + Shift ドラッグで、ライトの強度を変更できます。サッカーボールです
ぐに見て取れるほどの影響を与えるには、かなり高く設定する必要があり
ます。

08 ネットワークビューで、pointlights  ノードの出力を RMB クリッ
クし、Light と入力してから Enter を押してノードを配置し、そ

の Display フラグを設定します。

ノードをアクティブにした状態で、Shift + S を押して Specular モードを
オンにします。サッカーボールの右側をクリックして、鏡面反射が集中する
領域を定義します。 

Ctrl ドラッグでライトをサッカーボールから離し、Ctrl + Shift ドラッグで
ライトの強度を変更します。

Denoise

Solo
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パート 6

ルックデブ : マテリアル
マテリアルとシェーダは、LOP/Solaris のコンテキスト内で作成することもできます。この場合、シーングラフにマテリアルを追加してから、
ジオメトリに割り当てます。マテリアルは、Material Library ノード内で作成され、LOP/Solaris レベルで割り当てられます。背景にテク
スチャを追加するには、UV を作成して、マップを適切に配置できるようにする必要があります。 

01 ネットワークビューで Tab > Material Library を押し、既存
のノードのネットワークのすぐ上にノードを配置したら、それを 

backdrop  ノードに接続します。ノードをダブルクリックして、VEX Builder 
レベルに下がります。 

Tab > Principled Shader を押してノードを配置します。その名前を 
soccerball_mat  に変更します。Base Color を 白（1, 1, 1）に設定します。

このノードを Alt ドラッグして、2 つ目の Principled Shader を作成し、名前
を backdrop_mat  に変更します。Base Color を暗い緑色に変更します。

02 ステージレベルに戻り、Tab > Assign Material を押して、
sceneimport  と camera  ノードの間にノードを配置します。 

パラメータエディタで、Primitives の横の矢印ボタンをクリックし、ビュー
ポートで soccerball  ジオメトリを選択します。Enter を押し、Primitives 
フィールドにそのパスを追加します。Material Path の横にある矢印をク
リックし、ポップアップウィンドウで materials > soccerball_mat を選択
してから OK をクリックします。

+（プラス）ボタンをクリックし、backdrop  と backdrop_mat についても
この手順を繰り返します。

03 materiallibrary  ノードをダブルクリックして中に入り、
soccerball_mat  ノードを選択します。Textures タブをクリック

し、Base Color の Use Texture をクリックしたら、Texture の横のボタン
を使用してファイルウィンドウを開きます。横のリストで $HIP をクリックした
ら、tex  フォルダをクリックして開き、soccerball_color.rat  をワンクリック
して選択します。Accept をクリックし、テクスチャをマテリアルに割り当て
ます。 

$HIP 参照により、シーンファイルの位置に対して相対的に参照するように
なります。このようにすると、プロジェクトディレクトリを別のコンピュータ
に移動しても、引き続き参照が機能します。

04 Textures タブで、前の手順で学んだテクニックを使用して、
Roughness と Reflectivity にテクスチャを割り当てます。 

tex  フォルダで適切なテクスチャを見つけます。

マテリアルの Bumps & Normals タブに移動して、Enable ボタンをクリッ
クします。Texture Path の横にある矢印をクリックして、tex ディレクトリか
ら soccerball_normal.rat ファイルを選択します。Effect Scale を約 0.5 
に設定し、どうなるかを確認します。
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Houdini のマテリアル
Houdini のマテリアルは VEX Builder コンテキストにあり、この場合
は Material Library ノード内にネストされます。マテリアルは、マテリ
アルの品質を定義する VOP ノードまたは Material X ノードで構成さ
れています。 
Principled Shader は、単体でテクスチャマップを割り当て、多様な
ルックを生成できる優れたマテリアルです。独自のシェーダやマテリア
ルを構築して、より高度なルックを実現することも可能です。 

05 Scene View で、camera1  越しにショットを確認します。サッカー
ボールのロゴがカメラに対してよい位置にないので、ボールを回

転する必要があります。 

Scene View で、サッカーボールを選択します。Tab > transform を押しま
す。チェーンの終端に transform ノードが追加されます。Handle ツールで、
R を押して Rotate ハンドルにしたら、ロゴがきれいに見えるようにボール
を回転します。タンブルする必要がある場合もあります。

これは、Karma または Houdini GL ビューで行うことができます。変更が
気に入らない場合は、ノードを削除してもう一度試します。soccerball_
geo  を選択解除するには、シーングラフ でそれを Ctrl クリックします。

06 backdrop マテリアルにいくつかテクスチャマップを追加しましょ
う。materiallibrary  ノードをダブルクリックして、backdrop_

mat  ノードを選択します。 

Base Color を 1, 1, 1 に設定し、この色がテクスチャマップに乗算されるよ
うにします。Textures タブをクリックして、Base Color の Use Texture を
クリックします。ファイル選択ボタンをクリックして、$HIP から /tex ディ
レクトリに移動し、backdrop_color.rat  を選択します。Reflectivity  に 
backdrop_reflect.rat テクスチャを追加してもよいでしょう。 Scene View 
を見ると、UV が適切にセットアップされておらず、テクスチャマップも機能
していないことが分かります。

07 ステージレベルに戻り、backdrop  ノードをダブルクリックし
てジオメトリレベルに移動します。grid  と bend  の間に UV 

Project ノードを追加します。サーフェスを曲げる前に UV が作成されるよ
う、ここにノードを追加していきます。

uvproject  ノードで、Initialize タブをクリックして Initialize ボタンを押し
ます。Transformation タブに戻り、V Range を 0, -1 に設定します。これ
により、UV の方向が適切になります。

重要 : subdivide ノードに Display フラグを再度設定します。

08 ステージレベルに戻ります。ネットワークビューで、Tab > 
Karma を押し、Karma Render Settings と USD Render 

ROP ノードを追加します。それらをチェーンの終端に接続します。
karmarendersettings  ノードを選択して、Image Output > Filters タブ
で Denoiser を nvidia Optix Denoiser に設定してデノイザをオンに戻し
ます。

usdrender_rop  ノードを選択します。Render to Mplay ボタンをクリッ
クします。Mplay が開き、進行中のレンダリングが表示されます。File > 
Save Frame As を選択し、画像をディスクに保存します。

63

ル
ッ

ク
デ

ブ
 : 

マ
テ

リ
ア

ル



パート 7

サッカーボールのリギング
バウンシングボールのアニメーションを作成するには、シンプルなリグの作成からはじめます。これで、キーフレームが設定しやすくなりま
す。そのためには、ビューポートでインタラクティブに作業できるように、Null オブジェクトをセットアップします。また、サッカーボールの
ジオメトリネットワークにノードを追加して、ボールの回転、スクワッシュとストレッチを適用します。

01 Build デスクトップに戻り、パスバーの 1 つをクリックしてオブ
ジェクトレベルに移動し、obj  を選択します。ネットワークエディ

タで、soccerball_geo  を Alt ドラッグしてコピーを作成します。このノード
の名前を socccerball_anim に変更します。 

soccer_anim  を使用して、リグを構築します。soccer_geo  ノードの 
Display フラグをオフにして、非表示にします。元のセットアップは変更した
くありません。そのオブジェクトは、Solaris コンテキストのショット 1 で使用
されているからです。この新しいサッカーボールは、アニメートされるショッ
ト 2 で使用します。

02 Create シェルフで、Null ツールをクリックしてから Enter を押
し、それを原点に配置します。名前を soccerball_ctrl  に変更

します。Misc タブに移動し、Control Type を Circles に、Orientation を 
ZX Plane に設定します。Display Uniform Scale を 4 に設定します。 
これでリグのハンドルが作成されます。簡単に選択でき、後のレンダリング
工程ではレンダリングされません。

ネットワークエディタで、soccerball_anim  オブジェクトの入力を 
soccerball_ctrl  Null の出力に接続し、親子関係を作成します。Null を動
かすと、ボールも動くようになります。soccerball_anim  の選択フラグを
オフにして、アニメーションの間ビューポートで誤って選択しないようにしま
す。代わりに soccerball_ctrl を使用します。 

03 soccerball_ctrl  ノードを選択します。パラメータエディタで、
Transform タブをクリックしてから Translate X パラメータを 

RMB クリックします。Copy Parameter を選択します。 

soccerball_anim  オブジェクトの中に入ります。subdivide と matchsize  
ノードの間に Transform  ノードを追加します。Rotate Z を RMB クリック
し、Paste Relative References を選択します。このパラメータに、チャン
ネル参照のエクスプレッションが配置されます。

ch(“../../soccerball_ctrl/tx”)

これで、コントロールオブジェクトの動きがこのノードの回転とつながるよう
になります。

04 パラメータをクリックしてチャンネルを展開します。ボールの外周
（2 π r）を使用して、ボールが前進するときの回転を定めます。 

エクスプレッションを次のように変更します。
-ch(“../../soccerball_ctrl/tx”)*360/(2*$PI*1.1)

まず、先頭にマイナス（-）記号を追加します。その後、エクスプレッションで
ボールの位置に 360 度を乗算し、2 π r（πは $PI）で除算します。オブジェク
トレベルで、soccerball_ctrl  を X 軸に沿って動かします。エクスプレッショ
ンにより、ボールが動きに合わせて回転します。完了したら、ボールを原点
に戻します。

Alt ドラッグ
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05 ビューポートで、もう 1 つ Null オブジェクトを原点に作成しま
す。名前を squash_ctrl  に変更します。Misc タブに移動して、

Control Type を Box に、Display Uniform Scale を 0.2 に設定します。

Null をボールの真上に移動します。Translate Y は約 2.5 になるはずです。
パラメータエディタで、Modify Pre-Transforms メニューを選び、Clean 
Translates を選択します。これにより、Null が地面より上にあっても、その 
Translate Y 値が 0 に設定されます。Null でスクワッシュとストレッチを駆
動するためには、0 のデフォルト値が必要となります。

06 soccerball_ctrl  Null を squash_ctrl  Null の親にします。これ
により、コントロール Null をアニメートすると、このセカンダリ

の Null が動くようになります。 

squash_ctrl  ノードの Translate Y パラメータを RMB クリックします。
Copy Parameter を選択します。このパラメータを使用して、ボールのスク
ワッシュとストレッチを駆動します。こうすることで、ビューポートからインタ
ラクティブにスクワッシュとストレッチを制御できるようになります。

07 soccerball_anim  オブジェクトの中に入ります。matchsize  
の後に Bend ノードを追加します。Limit Deformation to 

Capture Region チェックボックスをオフにします。 

Right ビューに移動して Set Capture Region ボタンをクリックします。 
グリッドスナッピングをオンにして、ボールの底部と上部に 1 つずつポイン
トを配置します。これにより、Up Vector は 0, 0, 1、Capture Direction 
は 0, 1, 0、Capture Length は 2.2 に設定されるはずです。   

Length Scale と Preserve Volume をオンにしたら、Length Scale を 
RMB クリックして、Paste Relative References を選択します。エクスプ
レッションの最後に +1 を追加します。 

08 オブジェクトレベルに移動し、パースビューを表示します。
Transform X および Transform Z パラメータを RMB クリッ

クし、Lock Parameter を選択して、squash_ctrl  でこれらのパラメータ
をロックします Scale  および Rotate  パラメータを RMB クリックし、Lock 
Parameter を選択して 3 つすべてのチャンネルをロックします。 

soccerball_ctrl  オブジェクトを選択します。Translate X と Translate Y 
を除くすべてのチャンネルをロックします。これでコントロールを選択する
と、ロックされていないチャンネルのハンドルのみが表示されるようになり
ます。アニメータは選択したパラメータのみを操作でき、リグが扱いやすく
なります。

09 リグを X と Y で動かして、テストしてみましょう。2 つ目のハンド
ルを使用して、スクワッシュとストレッチを適用します。すべての

パーツがうまく機能していることを確認したら、すべての値を 0 に戻し、ア
ニメーションの準備をします。 

Scene View の左側のツールバーで Secure Selection をオフにすることを
お勧めします。Move ツールを使用している間、2 つのコントロール Null を
選択しやすくなります。オフにしない場合は、選択を切り替えるたびに S キー
を押す必要があります。 

シーンファイルを保存してから、次に進みます。
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Pose ツール
Move または Handle ツールを使用すると、サッカーボールのリグの 2 つのコン
トロールオブジェクトを簡単に操作できます。Pose ツールを使用する利点は、
Motion Path ハンドルにアクセスでき、インバースキネマティクスを使用している場
合は、専用のハンドルを使用できることです。そのため、リグにキーフレームを 
設定する場合は、このツールを必ず思い出してください。Secure Selection がオン
になっていても、Pose ツールで別のオブジェクトを選択可能です。

Select

Secure Selection [~]

Move [T]

Rotate [R]

Scale [E]

POSE [Y または Ctrl + R]

Handle [Enter]

01 タイムラインの左端の下段で、Global Animation Options ボ
タンをクリックします。End  を 120 に設定し、Close をクリック

します。これにより、タイムラインの範囲が 120 フレームに設定されます。 

フレーム 1 にいることを確認します。左側のツールバーで  Pose ツール
をクリックし、soccerball_ctrl  を選択します。ボールを X 方向の約 -15 に
移動したら、K を押してキーフレームを設定します。タイムラインをフレーム 
120 に移動します。ボールを X 方向の約 15 に移動したら、K を押して 2 つ
目のキーフレームを設定します。 

タイムラインをスクラブし、ボールがアニメートされていることを確認しま
す。リグの設計に基づいて、移動および回転するはずです。

02 タイムラインをフレーム 12 に移動し、K を押して中間のキーを
設定します。フレーム 36 と 60 で繰り返します。これらのキーフ

レームは、すべて地面上にあります。 

次にフレーム 1 に移動し、ボールを Y 方向に上げます。もう 1 つキーを設定
する必要はありません。この移動によって、フレーム 1 に既に設定してある
キーフレームが更新されるからです。

フレーム 24 に移動し、ボールをフレーム 1 よりも少し低い位置まで Y 方向
に上げます。K を押してキーフレームを設定します。フレーム 48 に移動し、
ボールをさらに少し低い位置まで上げます。K を押してもう 1 つキーフレー
ムを設定します。

03 タイムラインをスクラブすると、ボールが浮いたように見えます
が、ボールが着地するときは、強く当たるようにしたいわけです。

Animation Editor ペインタブをクリックします。 

Scoped Parameters リストで Translate Y  チャンネルをクリックします。 
H を押して、カーブのビューをホーム（リセット）します。ボールが着地する 
3 つのキーフレームを選択し、グラフのすぐ上にあるFunction ツールバー
で  Untie Handles ボタンを押します。何もない空間をクリックして選択
を解除したら、接線ハンドルを微調整して、着地の各ポイントのカーブを鋭
角にします。 また、上部のハンドルは平坦にして、バウンドのピークでボー
ルの速度を遅くします。 

パート 8

バウンシングボールのアニメーション
サッカーボールのリグを使用して、バウンドする（弾む）ボールをアニメートします。キーフレームを設定したり、アニメーションカーブを 
調整したり、ビューポートでハンドルを使って速度を調整する方法を学びます。バウンシングボールは、アニメーションの練習によく使われ
る課題で、Houdini でのアニメーションの基礎を学ぶのにも最適です。
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04 Scene View に戻り、結果をプレビューします。ボールが着地す
るたびに、弾むようになりました。Pose ツールがアクティブで、

soccerball_ctrl  ノードが選択されていることを確認します。上部のバーで、
Motion Path ハンドルをオンにします。これにより、ボールのバウンドのパ
スが表示されます。それぞれのキーフレームマーカーをクリックして、弾み
方を微調整します。カーブをより詳細に制御するには、ハンドルを RMB ク
リックして Show Tangents をオンにします。 

soccerball_anim  オブジェクトの Misc タブに移動して、Onion Skinning 
を Full Deformation に設定します。スペースバー + D を押し、Scene タ
ブで Frame Increment、Frames Before、Frames After のカラーを調
整します。   

05 タイミングの調整には、タイムラインも使用できます。Shift を押
し、フレーム 1 からタイムラインの最後のキーまで境界ボックス

をドラッグして、すべてのキーを選択します。次に、ボックスの端のハンドル
の下を MMB ドラッグして、バウンドのタイミングをスケールし、スピードを
上げます。MMB を使用して各キーを選択してから、MMB でドラッグしても、
それぞれのキーフレームのタイミングを好きなように調整できます。

ここでは、バウンドのタイミングを決定します。希望する動き方になるまで 
試してください。Translate X の値が原因で、弾み方が自然ではないかもし
れません。それは次の手順で修正します。

06 Animation Editor ペインタブをクリックして、2 つのカーブを
表示します。Scoped Parameters リストで、soccerball_ctrl  の 

Translate X をクリックします。最初と最後のキーを除く、すべてのキーを
選択します。Delete を押します。カーブハンドルを使用して、急な傾斜が
緩い傾斜に移行するようにします。こうすると、ボールの動きは始めが速く、
終わりでゆっくりになります。

Motion Path ハンドルで X 方向のポイントを再び調整すると、その方向には
中間キーがないため、おかしな結果になることに注意してください。これ以
降は、Y 方向の微調整にのみこのハンドルを使用します。

07 Scene View に戻ります。Motion Path ハンドルを RMB クリッ
クし、Persistent を選択します。これにより、スクワッシュとスト

レッチにキーフレームを設定する際のガイドとして、ハンドルを保持してお
けます。 

squash_ctrl を選択し、Motion Path をオフにします。最初のバウンドに
移動して、1 フレーム戻ります。squash_ctrl  のハンドルを選択し、ボール
を少し引き伸ばし（ストレッチし）ます。K キーをでキーフレームを設定しま
す。バウンドのフレームに移動し、ハンドルを下げてスクワッシュ（潰し）を作
成します。もう 1 つキーを設定します。1 フレーム進め、ボールが丸くなるま
でストレッチし（引き伸ばし）ます。もう 1 つキーを設定します。この手順を
すべてのバウンドで繰り返します。

08 完了したら、モーションをスクラブして再生し、結果をプレビュー
します。バウンドのピークで、ボールが引き伸ばされていること

を確認してください（ストレッチ）。モーションを正しく評価するには、タイム
ラインで  Real Time Toggle がオンになっていることを確認します。 
次に Animation Editor を使用して、スクワッシュとストレッチを微調整し
ます。キーフレームとサッカーボールのバウンドが揃っていることを確認しま
しょう。

ここを MMB ドラッグ
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Motion FX
キーフレームとアニメーションカーブはノードのパラメータに格納されますが、チャンネル
オペレータ（CHOP）を使用すると、よりプロシージャルなノードベースのアプローチでモー
ションを操作することができます。 
Motion FX は、Channel CHOP に抽出および格納される、キーフレームによる動きに適
用できます。その後、Cycle、Noise、Smooth、Limit、Lag などのエフェクトを既存の動
きに適用できます。Constraints シェルフにはさまざまなツールがあり、パラメータ設定
によってターゲットの方を向くようにしたり、遅延させたり、微震するようにできます。

10 動きの一部が地面の下にもぐっています。ボールが地面よりも上
で揺れるようにする必要があります。 

オブジェクトレベルに戻ります。soccerball_ctrl  Null オブジェクトを選択し
ます。Translate Y を RMB クリックし、Motion FX > Limit を選択します。
Minimum を 0 に、Maximum を 6 に設定します。これで、ボールはずっと
上下に揺れ動くのではなく、いくらか揺れながら地上を移動するようになり
ます。

11 ボールが弾んでいる間は、ノイズは必要ありません。ノイズが必
要なのは、ボールが転がりはじめてからです。Amplitude の

キーフレームを設定して、ノイズをオン/オフできるようにします。 

新しく作成した motionfx ネットワークで、noise1  CHOP ノードを選択
します。ボールが弾まなくなり、転がり始めるフレーム 37 に移動します。
Amplitude を Alt クリックして、キーフレームを設定します。フレーム 1 に
移動して、Amplitude を 0 に設定します。Amplitude を再度 Alt クリック
して、2 つ目のキーフレームを設定します。Animation Editor でカーブを
選択します。Function ツールバーの Constant ボタンをクリックします。 
これで、振幅なしから振幅 1 へとシャープに切り替わります。

12 完了したら、ウィンドウを閉じます。Motion Path ハンドルを 
RMB クリックして Persistent をオフにし、選択解除したらハン

ドルが表示されないようにします。 

Scene View の左側にあるツールバーで、  Render Flipbook ボタンをク
リックします。デフォルト設定のまま、Start をクリックします。シーケンスが
キャプチャされるまで待つと、Mplay ウィンドウにフリップブックが表示され
ます。これを再生したりスクラブして、動きを評価します。

作業内容を保存します。

09 soccerball_ctrl  Null オブジェクトを選択します。Translate Y 
を RMB クリックし、Motion FX > Noise を選択します。パネ

ルが開き、そこに表示されたパラメータを使用してノイズを制御できます。 
soccerball_ctrl  の Translate Y チャンネルに情報を送り返す CHOP ノー
ドを含む、新しいサブネットワークが作成されます。

Amplitude を 5 に設定し、Play を押してどのように見えるかを確認しま
す。上下に大きく動き、まるで激しい乱流のようです。Amplitude を 1 に 
設定して、ボールの動きに加わる揺れを少なくします。
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04 Select ツールを使用して、新しいアニメートされたサッカーボー
ルをクリックします。Scene View で、Tab > Transform を押し

て、Transform ノードをグラフに追加します。 

Scene View で、トランスフォームハンドルを使用してボールを中央の背景の
後方に移動します。タイムラインをスクラブして、ボールが弾みながら右に
進むことを確認します。フレーム 80 あたりで止めます。R を押して回転ハン
ドルを使用できるようにします。ボールを回転し、背景から斜めにバウンド
してくるように移動します。タイムラインをスクラブして、方向に問題がない
ことを確認します。 

01 オブジェクトレベルに移動します。soccerball_anim  をダブル
クリックして中に入ります。N を押し、すべてのジオメトリを選択

したら、Modify シェルフで Extract を選択します。これにより、ボールのす
べての動きと曲げが 1 つのネットワークにまとめられます。

ボールを extract_object という新しいオブジェクトに抽出している 
objectmerge  ノードが表示されます。その出力を RMB クリックし、USD 
Export を見つけたら、クリックしてこのノードを配置します。このノード
を soccerball_anim  という名前に変更します。Export タブをクリック
し、Valid Frame Range を Render Frame Range に、Output File を 
$HIP/geo/soccerball_anim.usd  に設定します。Save to Disk ボタンを
クリックします。

02 Solaris デスクトップに戻り、/stage  を指定します。ネットワー
クビューで、karmarendersettings  ノードの直前に Null ノー

ドを追加し、その名前を SHOT_01  に変更します。 

3 つの light ノード（lightmixer  ではありません）を接続解除し、それらを 
backdrop  ノードの上に移動します。これにより、最初のショットのルックは
変わらず、2 つのショット間でノードを共有できるようになります。

backdrop、light、materiallibrary  ノードを右に移動します。 

03 ズームインして、Reference ノードを backdrop  ノードの右下
に追加します。backdrop  ノードをこの新しいノードに接続し、

Display フラグを設定します。File Pattern の横にある File Chooser を
クリックし、soccerball_anim.usd  ファイルを見つけます。ノードの名前を 
soccerball_anim  に変更します。 

Houdini GL ビューでタイムラインをスクラブすると、USD ファイルの一部で
あるキャッシュ化されたアニメーションを確認できます。

パート 9

ライト、カメラ、アクション!
アニメートしたサッカーボールをレンダリングするには、Solaris 環境に戻って 2 つ目のショットをセットアップする必要があります。 
まず、背景ジオメトリから新しい LOP ノードを分岐させてから、バウンドするサッカーボールのアニメーションに合わせてライトとカメラを
調整します。また、変形するジオメトリに対してモーションブラーもセットアップします。
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KARMA レンダラ
Karma は、Solaris/LOP コンテキストで USD ファイルを使用できるよう設計さ
れた物理ベースの HYDRA レンダラです。ビューポートで使用してインタラク
ティブに更新したり、Karma ノードを使用してディスクにレンダリングできます。
注 : Houdini 19 は、Karma XPU レンダリングエンジンのプレビューに対応し
ています。このハイブリッドな GPU/CPU レンダラはアルファ品質で、多くの機
能はまだ開発中であるため、テスト目的でのみ使用します。XPU は、Scene 
View の Display Options または Karma ノードで選択できます。

ビューポートメニュー Display Options

06 左上から右下へと、ボールがカメラに向かってアニメートさ
れる様子が見えるまで、タンブルします。LOP Lights and 

Cameras シェルフで、Camera ツールを Alt クリックして、現在見ているア
ングルにカメラを配置します。 

Lock Camera/Light to View ボタンを押し、ビュー変更に応じてカメラの
位置が更新されるようにします。次にビューポートでタンブル、パン、ドリー
してカメラを微調整し、ショットに適したフレーミングにします。タイムライン
をスクラブし、シーケンス全体でカメラが機能していることを確認します。 

07 camera  の後に Light Mixer ノードを追加します。lightmixer  
ノードでは、ライト上にカーソルを移動します。こうすると、前に

紹介したライトハンドルを使用して、このショットのライティングを決定した
り、ビューポートの Karma 表示を使ってセットアップを確認することができ
ます。lightmixer  ノードを使用すると、このショットの強度や露出をさまざ
まに変えて試すことも可能です。 

これらの編集は lightmixer  ノードに保持され、元のライトは変更されませ
ん。lightmixer  では、マルチショットセットアップを使用しながら、既存のラ
イトを微調整できます。   

08 ネットワークビューで、SHOT_01、karmarendersettings、
usdrender_rop  ノードを Alt ドラッグします。lightmixer  ノー

ドをこのチェーンに接続します。新しい karmarendersettings  ノードを選
択し、Camera が /camera2  に設定されていることを確認します。Valid 
Frame Range を Render Frame Range に、Output Picture を $HIP/
render/anim/soccerball_anim_$F2.exr  に設定します。$F2  によって、
レンダリングにフレーム番号と 2 のパディングが追加され、/anim/  によっ
て、これらのフレームを保持するためのディレクトリが作成されます。 

usdrender_rop  ノードで、Render to Disk をクリックします。完了したら、
Render > Mplay > Load Disk Files を選択し、レンダリングした画像を開
いて最終的なシーケンスを確認します。作業内容を保存します。

05 ネットワークビューで、SHOT 1 ネットワークから 
assignmaterial  ノードを選択し、Alt ドラッグしてこのノードの

コピーを作成します。transform  ノードを assignmaterial  ノードに接続し
たら、Display フラグを設定します。これによりマテリアルが背景に割り当
てられますが、サッカーボールのプリミティブが変更されているため、マテリ
アルを割り当て直す必要があります。

soccerball_mat  の Primitives の横にあるフィールドで、プリミティブの
名前を /soccerball_anim に変更し、新しいジオメトリにマテリアルを割り
当て直します。
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04 フレーム 1 にいることを確認します。copytopoints  ノードの後
に RBD Bullet Solver ノードを追加します。 Collision タブをク

リックし、Ground Collision までスクロールダウンして、Ground Type を 
Ground Plane に設定します。Play を押して、シミュレーションをテストし
ます。シミュレーションはキャッシュ化され、タイムラインをスクラブして結
果を確認できるようになります。

Collisions タブで、Bounce を 0.8 に設定します。Properties タブで、
Density を 10 に、Bounce を 1.1 に設定します。このノードのパラメータ
エディタの上部で、Reset Simulation ボタンをクリックしてから Play を 
押し、再度シミュレーションを実行します。スクラブして確認します。

01 Build デスクトップに戻り、オブジェクトレベルに移動します。 
すべてのアニメーションリグノードと extract_object  ノードを、

Display フラグをオフにして非表示にします。soccerball_geo  の表示をオ
ンにします。

soccerball_geo  ノードを選択してから、Modify シェルフの Extract ツー
ルをクリックします。これにより、サッカーボールのオブジェクトが結合
された、新しいオブジェクトが作成されます。1 つ上のレベルに移動し、
extract_object の名前を soccerball_sim  に変更します。soccerball_
geo  オブジェクトを非表示にします。

soccerball_sim オブジェクトの中に戻り、ジオメトリを作業していきます。
Match Size ノードを追加して、原点を基準とした中央にボールを配置します。 

02 ネットワークビューで、Tab > Box を押し、それを matchsize  
ノードの右側に配置します。 

box  ノードで次のように設定します。 
	� Center を 0, 8, 0 にする
	� Rotate を 45, 45, 45 にする 
	� Primitive Type を Polygon Mesh にする
	� Uniform Scale を 6 にする
	� Axis Divisions を 3, 3, 3 にする 

これで、シミュレーションでの位置が適切になります。

03 ネットワークビューで、その他のノードのすぐ下に Copy to 
Points ノードを追加します。matchsize  ノードを 1 つ目の入力

に接続し、box  ノードを 2 つ目の入力に接続します。 

Pack and Instance オプションをオンにします。これにより、ジオメトリが
立方体のポイントにインスタンス化されるので、シミュレーションが高速化し
ます。copytopoints ノードに Display フラグを設定します。

ネットワークビューで、Tab > Mountain を押して、box  と copytopoint  
ノードの間にそのノードを配置します。Noise Along Vector オプションを 
オフにしてから、Amplitude を 2 に、Range Values を Zero Centered 
に設定します。これで、ボックスのポイントが微震するようになります。 

パート 10 

リジッドボディシミュレーションのセットアップ
1 個のサッカーボールをアニメートするには、従来のアニメーション方法が適していますが、たくさんのサッカーボールをアニメートしたい
場合は、ダイナミクスの使用がお勧めです。ダイナミクスを使うには、ソルバがフレームごとに各オブジェクトの相互作用を判断できるよう、
シミュレーションを行う必要があります。パックドジオメトリを使用すると、効率よくシミュレーションの結果を得られます。
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SOP 内に隠れた DOP
Houdini では、シミュレーションは Dynamic Operators、つまり DOP を使用して
処理されます。Geometry/SOP コンテキストの RBD Bullet Solver ノードでは、
内部にダイナミクスネットワークが埋め込まれたノードを使用することになります。 
これにより、すべての DOP ノードを接続して準備を整え、かつビューに表示されて
ない状態を簡単にジオメトリレベルでセットアップできるようになりました。シンプ
ルなセットアップでは、ジオメトリレベルで作業することで適切なシミュレーションを
得られます。さまざまなソルバをより詳細に制御する必要がある場合は、DOP で直
接作業する必要があります。 

05 チェーンの終端に USD Export ノードを追加し、Display フラ
グを設定したら、それを soccerball_sim  という名前に変更し

ます。 

Valid Frame Range を Render Frame Range に、Output File を  
$HIP/geo/soccerball_sim.usd  に設定します。 

Save to Disk ボタンをクリックして、USD ファイルを geo ディレクトリに
保存します。このキャッシュ化されたアセットは、3 つ目のショットとして 
Solaris セットアップで参照されます。

06 デスクトップを Solaris に戻し、パスを /stage  に設定します。
Persp  メニューで Houdini GL が選択されていることを確認し

ます。 

soccerball_anim Reference ノードを Alt ドラッグし、その Display フラグ
を設定します。File Pattern を $HIP/geo/soccerball_sim.usd  に設定し
ます。 

このノードを soccerball_anim  という名前に変更します。

07 ネットワークビューで、SHOT 2 ネットワークから 
assignmaterial  ノードを選択し、Alt ドラッグしてこのノードの

コピーを作成します。soccerball_anim  ノードを assignmaterial  ノード
に接続したら、その Display フラグを設定します。これによりマテリアルが
背景に割り当てられますが、サッカーボールのプリミティブが変更されてい
るため、マテリアルを割り当て直す必要があります。

soccerball_mat の Primitives  の横にあるフィールドで、プリミティブの
名前を /soccerball_sim に変更し、新しいジオメトリにマテリアルを割り当
て直します。

08 ボールがカメラに向かってアニメートされる様子が見えるま
で、タンブルします。LOP Lights and Cameras シェルフで、

Camera ツールを Alt クリックして、現在見ているアングルにカメラを配置
します。 

Lock Camera/Light to View ボタンを押し、ビュー変更に応じてカメラの
位置が更新されるようにします。次にビューポートでタンブル、パン、ドリー
してカメラを微調整し、ショットに適したフレーミングにします。タイムライン
をスクラブし、シーケンス全体でカメラが機能していることを確認します。 
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まとめ
Houdini のさまざまな側面に触れながら、ゼロからシーンを構築してきました。 
モデリング、テクスチャのセットアップ、レンダリング、シミュレーションを行いました。
その過程で、さまざまな Houdini コンテキストと、それらの切り替え方法についても
学習しました。
このレッスンは、VFX の大作を作るものではありません。
Houdini を深く探り、その包括的なツールセットを探求するに
あたって必要となる基本スキルを紹介する
ものです。
SideFX の Web サイトには、スキルアッ
プのための学習教材が豊富に用意され
ています。 
最高の旅になりますように!  

10 ネットワークビューで、SHOT_02、karmarendersettings、
usdrender_rop  ノードを Alt ドラッグします。 

新しい lightmixer  ノードをこのチェーンに接続します。新しい 
karmarendersettings  ノードを選択し、Camera が /camera3  に設定さ
れていることを確認します。 

09 camera の後に Light Mixer ノードを追加します。lightmixer  
ノードでは、ライト上にカーソルを移動します。こうすると、前に

紹介したライトハンドルを使用して、このショットのライティングを決定した
り、ビューポートの Karma 表示を使ってセットアップを確認することができ
ます。lightmixer  ノードを使用すると、このショットの強度や露出をさまざ
まに変えて試すことも可能です。 

これらの編集は lightmixer  ノードに保持され、元のライトは変更されま
せん。lightmixer  では、マルチショットセットアップを使用しながら、既存の
ライトを微調整できます。   

11 usdrender_rop ノードで、Valid Frame Range を Render 
Frame Range に、Output Picture を $HIP/render/sim/

soccerball_sim_$F2.exr  に設定します。Render to Disk をクリックし
ます。 

完了したら、Render > Mplay > Load Disk Files を選択し、レンダリング
した画像を開いて最終的なシーケンスを確認します。

73

リ
ジ

ッ
ド

ボ
デ

ィ
シ

ミ
ュ

レ
ー

シ
ョ

ン
の

セ
ッ

ト
ア

ッ
プ




